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Day 1 Agenda
- A brief introduction to Schrödinger’s design platform

- First steps in Maestro

- Preparing proteins

- Understanding the binding site

- Lunch (12:00 – 13:00)

- Designing new ligands: quick ideation

- Preparing ligands and docking with Glide

- Q&A and closing (15:00)
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Download workshop files & slides from here: https://bit.ly/3FnoSeM
Link will remain active until Friday

Downloading the workshop files

https://bit.ly/3FnoSeM


A few words about us
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Get to know complex workflows at your own pace

https://www.schrodinger.com/learn/training
/schrodinger-online-learning



Getting Started
Visualization basics



● Hover over it or right-click on it

○ Tooltips let you know what a button does

○ Almost everything gives more options for interactions via right-click

● ? Button in the panels

○ Takes you to the appropriate part of the documentation

● Search the Documentation

○ Finds both technical documentation and tutorials

● Search the Tasks Tool

○ If you don’t know what it is called or to see if it is available

○ Hit enter with a search term

Some tips and tricks: Getting unstuck
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Project Setup for Day 2

2. Set to where Maestro should put 
results of calculations and other output
My recommendation: inside project folder

3. Fetch BACE-1 structure from the PDB

0. In case you’re using a trackpad or are used to PyMOL:

1. Choose where project data 
should be saved



Getting familiar with BACE-1 (PDB id: 4DJX)
zoom and fit view (to all, selection, or ligand)
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apply visualization presets
(double-click to apply default preset)

Toggle display of Labels and Interactions

To reproduce: apply default preset, toggle labels off and interactions on, zoom to ligand, adjust camera

Select Atoms Rotate Translate Zoom

Default Maestro mouse/camera controls: 



11

Getting familiar with BACE-1: Tweaking the style
quick selection shortcuts: Protein, Ligand, Solvent, and more change display of selected entities

right-click menus recognize context

quickly switch between selection modes

“+”  or Ctrl-Click to add to 
selection

search and navigate semantically

Try to reproduce this view: 
color ribbons by CA Atom Color, remove all labels, find and select Asp pair, show 

as thin tubes, add labels for Asp pair only

For labels, ribbons, 
surfaces:

- Add/Remove 
them here

- Show/Hide 
them here:



Preparing Proteins
(the basics)
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Where are my hydrogen atoms?

protein crystal diffraction pattern electron density map atomic model



Not all Crystal Structures are Created Equal
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In this case, the ligand density is 
relatively unambiguous.

In this case the density is missing, which 
may result in misleading information.
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These all look very similar in X-Ray experiments!



How do I prepare a protein?

Protein Preparation Workflow takes care of:

- Alerting you to potential issues in the structure
- Adding in missing atoms, residues, and short loops
- Adding hydrogen atoms to achieve sensible 

protonation states for given pH
- Constructing a reasonable hydrogen-bond network
- Resolving common issues and ambiguities in the 

crystal structure
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Find “Protein Preparation 
Workflow” in Tasks

reset panel to defaults

For more control you 
could switch to 
interactive mode

Link to documentation



17

Preparing our Protein I: What’s in the structure?

2. Ctrl+Click to also select Chain B 
→ Expand selection to PDB Chain 

1. Select TLA from chain A

3. Create copy of the entry with deletions applied

We prepare only chain A and delete TLA:
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Preparing our Protein II: Running the Preparation

For now, leave all settings at their default value, 
give your job a memorable name and run it

Don’t delete the waters 
here unless your structure 
is too big otherwise
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Before and after protein preparation

To reproduce: include both 4DJX-with-deletions and 4DJX-prepared, 
re-apply preset, tile the workspace (“+” workspace widget)
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Visualizing the Pocket in 2D
Find “Ligand Interaction Diagram” in the tasks menu or the favorites bar 2D projection tied to 3D camera position
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- Some workflows require a ‘dry’ structure, 
e.g. SiteMap, Glide docking

- For all MD based workflows, X-ray waters 
are helpful as the protein must be solvated

Best practice recommendations: 
- Keep waters through to the end of the 

preparation workflow
- Duplicate your structure and rename it 
- Select all water molecules and delete them
- Use ‘wet’ or ‘dry’ structure as appropriate

What to do with the crystal waters?

click selected entry to rename

Make sure the 
“4DJX-prepared-dry” 
structure is included!



using SiteMap

Understanding the 
Binding Site



23

Many tools provide insight into the binding pocket

Protein Reliability 
Report/PrimeX

● Structure liabilities
● Missing density
● Structure 

refinement

Static

Protein 
Preparation 
Workflow

● Add  missing 
atoms

● Remove 
crystallography 
artifacts

● Protonation and 
tautomeric states

● Relaxation

Static

SiteMap

● Identify potential 
binding sites

● Characterize 
binding site

Static

WaterMap

● Identify hydration 
sites

● Calculate the 
energetics of 
waters

Dynamic

Mixed Solvent 
MD (MxMD)

● Identify potential 
cryptic binding 
sites

● Allow protein 
structure flexibility

● Uses small 
molecule probes

Dynamic



What does a binding site look like?
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concave pocket
specific interaction 
points for recognition 
or functionality

at least partially 
hydrophobic residue type: hydrophobic, polar uncharged, positives, negatives

PDB: 1FJS (human Factor Xa)
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A rough overview of the shape of BACE-1
One way to render the protein surface:

Right-click surface to configure:

Toggle display of individual surfaces or all surfaces at once
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An empty binding site is a high-energy state!
- apo and holo conformations can be very different

↳ hand-in-glove, not key-in-lock
↳ cryptic pockets are induced by ligand binding

What does an “empty” binding site look like?

Structures of TEM1 cryptic pocket (left: 1JWP, right: 1PZO)
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● experimentally: ligand-bound crystal structure, multiple-solvent crystal structures
● computationally:

● compare with homologs to find binding-site-like sequence or structure patterns 
- can work well for representatives of a populous class of proteins (e.g. kinases)

→ homolog with validated binding site is very helpful here

● scan surface topology to identify cavities likely to be pockets
- can use a mix of geometry, energy, and other physchem properties
- can work either on 

- static structure of target (quick, but cannot account for flexibility of protein) 
- or incorporate full dynamics (computationally expensive, but can find cryptic pockets)

● variety of methods available, consensus methods (knowledge+physics) can help de-risk

Sidenote: how do we find where binding sites are?
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How SiteMap finds and scores sites:

Halgren, T., J. Chem. Inf. Model., 2009, 49, 377–389.; 

overlay grid, 
discard internal points determine enclosure group points as sites, 

bridge gaps
sample interactions with 

water-like probe

calculate scores for each site based on:
‐ size of the site (larger sites are usually preferred)
‐ openness to solvent  (deep sites have lots of functionality)
‐ hydrophobic vs philic character (hydrophobicity aids binding)
‐ donor vs acceptor character (good ligands tend to donate)

SiteScore: Can the site bind ligands tightly?
- calibration: 

> 0.8 reasonable, > 1 promising

DScore: Is the site druggable?
- calibration: > 1 promising

Volume, Balance, …:  SiteMap User Manual

https://www.schrodinger.com/sites/default/files/s3/release/current/Documentation/html/sitemap/sitemap_user_manual/sitemap_user_manualTOC.htm?tocpath=Small%20Molecule%20Drug%20Discovery%7CProduct%20Documentation%7CSiteMap%7CUser%20Manual%7C_____1
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Using SiteMap: Evaluate
find SiteMap in the tasks menu

click ligand in workspace to select it 

Make sure you’ve included the ‘dry’ 
structure without waters!
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Interpreting SiteMap results
toggle white sphere display here

include all output entries by Ctrl+Clicking 
the empty circles

character of pocket: lipophilic, donor preferred, acceptor preferred

To view site metrics:



Designing Ligands
quick ideation with targeted enumeration and docking



Getting started with Designing Ligands
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● Open a new Maestro session

● File → Open Project…
Find LIGAND_DESIGNER_BACE.prjzip in the provided files

● Include everything in the STRUCTURE FOR ANALYSIS group

● Find “Ligand Designer” in Tasks and open it:

 
● Click “Analyze Workspace”



Now let’s tweak our ligand!
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customize what to show/highlight

customize MPO function

e.g.: sort selected 
ligands by MPO score

mark ligand idea as favorite

choose a workflow:

arrows highlight possible modification 
vectors

follow the prompts in the banners

Some Ideas:
- Remove Thiazole group



Ligand Preparation & 
Docking

setting up and validating a docking model



Different goals in HitID and LeadOpt require different tools
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Target
selection

Hit 
identification

Lead
optimisation Clinical trialsCandidate

selection

• Aim of virtual screening is to 
filter down large libraries of 
diverse compounds

• Requirement is enrichment 
wrt random screening, and 
to find diverse hits

• Additional properties are 
nice to have but less 
important at this stage

• Aim of virtual screening is to 
rank order congeneric 
compound ideas

• Requirement is to accurately 
predict binding and rank 
similar compounds

• Compounds have to 
optimally balance activity 
and other properties

✓ ━
✓ ━
✓ ━
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These questions are complex, and cannot be answered by individual tools
⇒ combine tools in concerted, validated workflows to get a rigorous answer!

This afternoon’s questions:

How well does this 
ligand idea fit into the 

target?

Which of these ligands 
is the tightest binder?



What do we mean by docking?
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What do we hope to achieve?
- generate a realistic pose of the bound ligand
- distinguish between binders and non-binders
- get a (semi)quantitative measure of how strongly the ligand binds → scoring



What’s the point of scoring?
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- A useful scoring function…  
- provides enrichment
- does well comparing diverse cpds
- is very efficient to calculate

- A useful scoring function…  
- is a proxy for the binding affinity
- does well comparing similar cpds
- prioritizes accuracy over speed

Hit 
identification

Lead
optimisation



Many docking algorithms and scoring functions:
- placement: systematic, MD-based, shape-based, genetic algorithms
- scoring: force field, empirical, knowledge-based, machine learning 
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How to Approach Molecular Docking

Friesner, R. A.  et al, J. Med. Chem., 2004, 47, 1739-1749.
Halgren, T. A.   et al, J. Med. Chem., 2004, 47, 1750-1759.
Friesner, R. A.  et al, J. Med. Chem., 2006, 49, 6177-6196.
Repasky, M. P. et al, J. Comput. Aided Mol. Des., 2012, 26, 787-799.

Challenges: 
- computational cost of treating the receptor flexibly is immense 

→ most docking tools use rigid-receptor docking

- tricky to find both efficient to calculate and binding-affinity-like scoring functions
→ focus on distinguishing binders from non-binders 
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Rigid-Receptor Docking using Glide

Prepare 
Protein & Ligands Setup Docking Validate Model Analyze 

ResultsDock & Score

- Get to know your system
- find the binding site → SiteMap, MxMD, …
- pay attention to protonation/tautomer states

- Use a ligand-bound structure
- lacking an experimental structure, use IFD-MD

- Pay attention to flexibility of binding site
- compare to homologs, across ligands, run MD

- Decide which waters to keep (after PPrep)
- structural waters: check literature+WaterMap

⇒ if in doubt, use ensemble of structures



Ligand Preparation
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Brc1ccc(CNCCN2CCN(Cc3cc4ccccc4[nH]3)CC2)cc1



Recommendations for Ligand Preparation
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• Glide will only dock ligand states that are provided and only 
scans torsions

• Use LigPrep to generate low energy ionization/tautomeric 
states for ligands

• Typical expansion of compounds by 
ionization/tautomeric/stereo expansion is 2.5x

• Increase or decrease pH value and +/- range depending on 
target physiological location and project goals

State penalty
= 0.0 kcal/mol

State penalty
=1.43 kcal/mol

Methotrexate bound to DHFR (1U72)



Setting up Ligand Preparation
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Select both known actives 
and decoys

find LigPrep in the tasks menu

Adjust pH

Name your job and run it

● Open a new Maestro session
● File → Open Project…

Find BACE_docking_start.prjzip in the provided files
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Generating ionization/tautomer states

• Four options currently: 

– simple rule-based → very fast, but struggles with complex chemistry

– Epik(-classic) → still fast, but should do well for most systems

– Epik7 → ML-based, in beta in 22-3 release (not in LigPrep GUI yet),
  better than Epik-classic across the board

– QM pKa prediction → very costly, does not generate states for you, but gives you 
information to understand detailed acid-base behavior

• Epik state penalties estimate free energy required to generate ionization state in water with 
corrections for interaction with metal sites
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Rigid-Receptor Docking using Glide

Prepare 
Protein & Ligands Setup Docking Validate Model Analyze 

ResultsDock & Score

Glide is optimized for speed:
- uses “gridded” representation of the binding site to speed 

up calculations
- ligands must fit within outer box,

ligand centers must lie within inner box
- only scans rotational DOF of ligands
- employs a funnel to discard bad ligands and poses without 

calculating costly interactions
- focuses on giving good poses and separating binders from 

non-binders



Setting up the Receptor Grid

46

find Receptor Grid Generation 
in the tasks menu

Make sure you split your prepared 
structure to extract ligand and solvent

Include “4DJX - prepared_protein”  and
“4DJX - prepared_ligand”

Click the ligand to define the binding site:



Setting up the Receptor Grid: Constraints
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Define any constraints you consider 
using now, we can choose whether 
to actually use them later.

Find and click the Asp oxygens in the workspace
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Grid generation

Scaling of van der Waals radii of nonpolar atoms 
decreases penalties for close contacts and can be used 
to model a slight "give" in the receptor and the ligand.

Peptides are more flexible than small molecule ligands – 
Glide can dock short peptides, but for anything longer 
than ~15 residues, use dedicated peptide docking tools.

Aromatic H-bonds and halogen bonds are not 
scored the same as regular H-bonds by default. 
If they are essential in your system, you may 
want to change that here.
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Grid generation

Specify ligand size to be docked (size of outer grid box). 
Increase if docked ligands are larger than the reference 
used to define the grid, but keep as small as possible.

In the advanced settings the inner grid box can be 
specified (where the ligand centroid will be placed 
during docking). Increase if ligands might occupy 
different parts of the binding pocket.

May be useful if your reference ligand sits off-center in a 
larger pocket.
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Grid generation – Constraints

- Constraints are used to bias Glide if the docked poses 
do not match experimentally validated poses. 

- You should define any constraints you consider using 
here, you can choose whether to actually use them 
later.

- Validate your model by docking known actives both 
with and without constraints.
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Rigid-Receptor Docking using Glide

Prepare 
Protein & Ligands Setup Docking Validate Model Analyze 

ResultsDock & Score

Retrospective analysis is essential for model validation:

– evaluate how well methods work in general, whether they work on your specific target, whether they 
are configured correctly 

– use the most similar retrospective setting
– usually done on a set of known active and inactive compounds (or decoys)
– in HTVS, evaluation is done using metrics like enrichment or correlation
– re-docking co-crystal ligands, known actives and inactives is good practice

⇒ The more data you have for your target, the more rigorously you can validate!
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Rigid-Receptor Docking using Glide

Prepare 
Protein & Ligands Setup Docking Validate Model Analyze 

ResultsDock & Score

– Details on how Glide finds docked poses can be found in the user manual.

– There are three main scores from a Glide run:
– GlideScore:      Base score of a docked pose
– docking score: GlideScore (+ Epik state penalty + strain penalty)

– used to rank diverse ligands
– emodel score:  Reweighed GlideScore + interaction energy + ligand strain

– used to rank poses of the same ligand

⇒ Remember: none of these scores used for rank-ordering of similar ligands

https://www.schrodinger.com/sites/default/files/s3/release/current/Documentation/html/glide/glide_user_manual/glide_overview.htm?tocpath=Small%20Molecule%20Drug%20Discovery%7CProduct%20Documentation%7CGlide%7CUser%20Manual%7CGlide%20Overview%7C_____0


Docking our Set of Ligands 
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find Ligand Docking 
in the tasks menu

Navigate to your glide-grid_BACE_4DJX_dry.zip 
(found in the project’s working directory)

select ligprep_BACE 
group in the entry list

we’ll run docking twice:
1. no constraints on
2. both constrains on

give your two jobs distinct names, e.g.
“glide-dock_BACE_noConstraints” and 
“glide-dock_BACE_hbond”
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Docking Setup Settings – Glide Modes & Sampling
– HTVS mode is for scanning through extremely large datasets.
– Standard-precision (SP) docking is appropriate for screening ligands of 

unknown quality in large numbers (general-purpose mode).
– Extra-precision (XP) docking and scoring is a more powerful and 

discriminating procedure, which takes longer to run than SP with 
additional scoring function terms. XP is designed to be used on ligand 
poses that have been determined to be high-scoring using SP docking.

– Peptide mode does not exhaustively sample ligand conformations and 
should be used with a grid generated for peptide docking

Useful to put additional emphasis on conjugated pi groups if 
docked poses do not match experimental results

Increasing the sampling can help if poses for known binders are not found:
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Docking Setup Settings – To Constrain or Not?
– Unbiased docking is usually best to start with to 

see if the ligands can be docked without 
incorporating any additional constraints

– Biased docking can be useful when 
– unbiased docking fails but specific interactions are 

known to be important, or 
– the ligands are highly similar (e.g. for generating 

poses for FEP calculations)
– Validate your choices by re-docking known actives 

and inactives

Sidenote: LigandDesigner uses maximum common 
substructure docking to quickly find binding poses for ideas
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Docking Setup Settings – Reporting Options

For virtual screening we usually only need the top pose, but for 
binding mode prediction we might be interested in more poses.
(Note: these should be ranked by emodel score, not GlideScore)

Number of poses in post-docking minimization 
should be 3-5 times larger than the number of 
reported poses

Allows visualizing contributions of each residue to 
final ligand score
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Rigid-Receptor Docking using Glide

Prepare 
Protein & Ligands Setup Docking Validate Model Analyze 

ResultsDock & Score

– Rank distinct compounds by GlideScore and 
multiple poses of the same compound by 
emodel score

– Visually inspect poses to recognize scoring 
function failures

– Some unfavorable torsions or interactions 
with the protein may be acceptable, as a 
small conformational shift in the receptor can 
resolve them



Analyzing Docking Results: Pose inspection
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Visual inspection of poses



Comparing Docking Models for HTVS: Enrichment
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How well does the docking 
separate binders from 

non-binders?

without H-bond constraints: with active H-bond constraints:



Correlation of Docking Results to Binding Affinity
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– In many compound sets, there is only a very weak 
correlation between docking score and experimental 
binding affinity or none at all.

– Generally docking score can not be used to 
distinguish between less and more active 
compounds

⇒ Reminder: the docking score is parametrized to efficiently distinguish binders from 
non-binders, not as a proxy for binding affinity



Closing and Q&A



Documentation:
Click        in any panel, or go to Help > Help...

Getting Help
• Knowledge Base: 

https://www.schrodinger.com/kb/

• Support Center: 
https://www.schrodinger.com/supportcenter

• Training Center: 
https://www.schrodinger.com/training

• Schrödinger Seminar Series: 
https://www.schrodinger.com/seminars/current
https://www.schrodinger.com/seminars/archives

• Script Center: 
https://www.schrodinger.com/scriptcenter/

• Scientific & Technical Support:
help@schrodinger.com
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https://www.schrodinger.com/kb/
https://www.schrodinger.com/supportcenter
http://www.schrodinger.com/supportcenter/
https://www.schrodinger.com/training
https://www.schrodinger.com/seminars/current
https://www.schrodinger.com/seminars/archives
https://www.schrodinger.com/scriptcenter/
mailto:help@schrodinger.com


Thank You!




